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MATH 1342 Elementary Statistics 

Session:  Spring 2009 
 

Synonym and Section: 1342.014 
(31266) 

Time:  MW  1:20 p.m. –  2:35 p.m. 

Classroom:  NRG 2245 

 

Instructor: Dr. Mary Parker 

Office Number: NRG 2147 

Office Phone: 223-4846  
                     (fax 478-6814) 

Email: mparker@austincc.edu 

Web: 
www.austincc.edu/mparker/1342/  

and 

http://www.whfreeman.com/ 

portals/bps4e  

Office Hours: MW 10:00 – 11:00 a.m. NRG 2147  
                         MW 2:35 – 3:05 p.m. NRG 2147                

                         MW 4:35 – 5:35 p.m. RVS 8131 (no phone) 

By appointment: (Email at least a day in advance to ask for 

an appointment) 
Mon. 11:00 – 1:15 p.m. NRG 2147 

Wed.  11:00 – 11:30  a.m. NRG 2147 

Wed. 3:05 – 3:30 p.m.  NRG 2147 

MW 4:05 – 4:35 p.m. RVS 8131  (no phone) 
Mon 7:00 – 8:00 p.m. RVS as arranged (no phone) 

Additional times for appointments may be available for 

students who cannot attend these and for whom email and 
phone conversations have proved to be inadequate to resolve 

problems. 

 

Course Description:  A first course in statistics for students in business; nursing; allied health; or the 
social, physical, or behavioral sciences; or for any student requiring knowledge of the fundamental 

procedures for data organization and analysis. Topics include frequency distributions, graphing, measures 

of location and variation, the binomial and normal distributions, z-scores, t-test, chi-square test, F-test, 
hypothesis testing, analysis of variance, regression, and correlation. Prerequisites: A satisfactory score on 

the ACC Mathematics Assessment Test. A second option is an appropriate secondary school course 

(Algebra II) and completion of any TSI-mandated mathematics remediation. ( ) Course Type: T  

 
Note: Texas State University recently changed their Transfer Guide to show that MATH 1342 is no 

longer considered equivalent to their QMST 2333 (Quantitative Methods).   ACC’s BUSG 2371 is the 

correct equivalent to that course, which is needed for most majors in business. 
 

Statement of Prerequisite Requirements:  Students who have passed the THEA math or COMPASS 
math to be eligible for college-level courses have satisfied the math prerequisite requirement.  Students 

should also have college-level reading skills. Students who are exempt from TSI requirements should 

have had two years of high school algebra to satisfy the prerequisite.   

Students in MATH 1342 will be expected to: 
 1.  understand material from the text after reading it. 

 2.  do homework using fairly complicated formulas after seeing one example 

 3.  do some, but not much, algebraic manipulation of formulas 
  

Required Materials:   One package includes both text and StatsPortal 

 The Basic Practice of Statistics, 4
th
 ed., by David S. Moore 

 Stats Portal website to accompany this textbook.  Includes the required MINITAB Manual  to 

accompany our text and other supplements, including the text as an e-book with links to detailed 

answers to the exercises, tutorials, applets, and more.    (See  

http://www.austincc.edu/mparker/1342/tf/  for details.) 
To sign up for StatsPortal at < http://portals.bfwpub.com/bps4e.php >  you’ll need  

 The activation code in the StatsPortal folder or you can purchase access online.  

 Your permanent email address (Can’t change this in the account) 

 Your instructor’s name 
 

Required Technology:  (More information – http://www.austincc.edu/mparker/1342/tf) 

1. Scientific calculator  (You are not allowed to use a graphing calculator on the tests.)   

2. Access to MINITAB computer software. For classroom sections, you are not required to buy this. 
Use it in the math labs, ICTS labs, and the Learning Labs.  http://irt.austincc.edu/CollegeComputers/  
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If you rent or buy a copy, please see the appropriate section of the above website for information in 

installing it and making the textbook data available to it.  (You can use the StatCrunch software in 
StatsPortal at home to explore data, so you should not need to rent or buy MINITAB.)   

3. Internet access.  For the Discussion Board and to access the various supplements in StatsPortal. 

 

Instructional Methodology:  This course is taught in the classroom as a lecture/discussion course.   
 

Course Rationale:  Students will learn to 
1. Determine the aspects of a question, if any, for which statistics can provide relevant information. 

2. Analyze statistical studies, particularly regarding appropriate sampling and experimental design. 

3. Select and use appropriate statistical analyses to get useful information from data. 
4. Communicate knowledge using standard statistical language and also interpret it in non-technical 

language. 

This course meets the Core Curriculum requirement in mathematics.  It meets the requirement for an 
introductory statistics course for students in many majors such as business, health sciences, and social 

sciences.    
 

Calendar:   

Week  

begins 
Material 

covered 

 

 1 1/20 1  

 2 1/26 2, 3  

 3 2/2 4, Test 1, 5 Test 1 through  

Ch. 4 

 4 2/9 5, 6  

 5 2/16 7, 8,  

 6 2/23 Data ethics, 

9,Test 2 

Test 2 through  

Ch. 9 

 7 3/2 10, 11  

 8 3/9 14, 15  

 9 3/23 15, 16  

10 3/30 17, Test 3, 

18 

Test 3 through   

Ch. 17 

11 4/6 19  

12 4/13 20, 21  

13 4/20 22, Test 4, 

23 

Test 4 through  

Ch. 22 

14 4/27 24  

15 5/4 optional 

chapter 

 

16 5/11 Test 5 Test 5 –  

Final Exam 

 
Course objectives:  Specific topics included are: 

1. Interpret ideas of population versus sample, random variables, and techniques of descriptive 

statistics including frequency distributions, histograms, stem and leaf plots, boxplots, and 
scatterplots.  

2. Calculate and interpret measures of central tendency and dispersion, including mean, median, 

standard deviation, and quartiles.  
3. Apply the 68-95-99.7 rule to normal distributions and use the normal tables to answer questions 

about the proportion of scores in a certain range or find various percentiles.  

4. Analyze relationships between two quantitative variables using correlation and linear regression. 

Analyze residual plots and determine how to handle outliers and influential points.  
5. Analyze data presented in two-way and three-way tables to provide information about 

relationships between categorical variables, including understanding and interpreting situations to 

which Simpson's Paradox applies.  
6. Apply ideas of appropriate sampling techniques and experimental design to data production.  

7. Use the basic ideas of probability and apply them to statistics.  

8. Use the sampling distributions of sample proportions and sample means to answer appropriate 

questions.  
9. Estimate single means, difference of two means, single proportions and difference of two 

proportions using confidence intervals. Interpret the results.  

10. Demonstrate skills in hypothesis testing for means and proportions, for single populations and 
comparison of two populations.  
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11. Demonstrate skills in hypothesis testing using the chi-squared test to compare several proportions 

and to test independence.  
12. Demonstrate skills in inference for regression or ANOVA techniques.  

Throughout the course, students will learn to do almost all the calculations by hand with a scientific 

calculator on small data sets and also students will learn to use a substantial statistical computer software 

package to do the statistical calculations quickly and on larger data sets. Some of the more advanced 
regression analyses will not be done by hand.  
 

Grading:   
Grades.  Your six grades will be averaged:  five tests and one daily work / homework grade. 

        A:  90-100;       B:  80-89;        C:  70-79;          D:  60-69;         F:  below 60 

If you believe that I have made a mistake on grading anything, write a note of explanation on a 
separate sheet of paper, staple it to the paper, and turn it in for re-grading. I am happy to discuss 

this with you outside of class, but grades will never be changed or corrected “on the spot”.  Such 

corrections must be made very soon after the paper was originally graded.   No grades will be 

corrected except through this procedure.   

 

Tests.  Several of the first four tests will be in the Testing Center at NRG and the last test will be 

in class on the last day of class.  You may prepare some handwritten notes and use them on the 
test.  These will not be comprehensive.  Enough room is provided to enable you to write a few 

formulas or procedures that you are having trouble memorizing.  Those notes must be  

         in your own handwriting  
        turned in with the test 
        originals, not copies, particularly not copies that are reduced 
         include only words and formulas  (Do NOT include worked-out examples.)   

For Test 1, you may take ONE sheet of paper for notes, front only.  

For Tests 2-3, you may take ONE sheet of paper for notes, front and back. 

For Test 4, you may take TWO sheets of paper for notes, front and back.   
For Test 5, you may take THREE sheets of paper for notes, front and back.    

The Testing Center Monitor will not necessarily tell you if your notes are in violation of 

the class rules.   You are responsible.  If you violate any of the rules about notes, I will 

either give you a zero on that test or else deduct some points from your test grade, 
depending on what I judge to be the severity of the violation.     

 

Tests must be done entirely on your own, with no help from anyone else.  Violating the 
rules of the testing center, or giving or receiving help on tests is scholastic dishonesty, and the 

punishments are severe. 

In the Testing Center, you will need your ACC student ID and a picture ID, like your 

driver’s license, and you will need to know the instructor's name, course number and section 
number.  (I also teach a distance learning section of this course, which has different tests.)  Also 

see the section of this handout on “Testing Center.” 

Tests must be taken in one sitting – no leaving to go to the restroom or any other reason.  
If you are unable to take tests in one sitting, please tell the instructor at the beginning of the 

semester so that she can help you make arrangements for the accommodations you need.  It will 

not be possible to make such accommodations if you wait until time for the test to ask. 
 For Tests 1 – 3, a student who misses a test or who makes below 60 on a test may come 

to me for additional make-up work.  This will usually include taking another test.  When that 

work is satisfactorily completed, the test grade will be raised to a 60.  Test grades of above 60 

can only be earned by taking the regular test on time.  Such make-up work can be done on no 
more than two tests and some part of the make-up work must be turned in within a week of when 

the test is returned.   (No makeup is provided for Test 4 because it is too late in the semester for 

makeup work to be completed.) 
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 The lowest of the grades on Tests 1 – 3, if it is a 60 or higher, will be replaced by the Test 

5 / Final Exam grade.   
 Deadlines for the tests will be enforced very strictly.  When the test is in the testing center 

from Monday through Wednesday, you are expected to take the test on Monday or Tuesday, and 

then there is an extra day for you to take it late if your car broke down on Tuesday. 

 
Homework.  The list of homework problems for the course will be made available several 

chapters at a time, before they are covered in class.  You are responsible for doing the problems 

over the material covered in class each day by the next class, checking your solutions, and asking 
your questions during the next class, office hours, or on the class Discussion Board.  Turn in the  

homework the next class after each test.  Each of the five homework sets will be graded on a scale 

of  0 – 20 and the five grades are combined for one homework grade of  0 – 100.  That grade will 
be averaged with the daily quiz/project grade and that average will count as much as one test.  

Students who make above 90 on both Tests 1 and 2 will be allowed to not count homework in 

their final grade, but instead use the daily quiz/project score alone for that part of the grade. 

 
Daily Quizzes.   These are used to measure your attendance as well as you are keeping up with 

the material in the course.  Students occasionally miss class for good reasons but it is important to 

keep up with the new material.  Thus, these quizzes may not be turned in late for any reason.  
Instead of accepting late quizzes, I provide a substantial amount of extra credit work.   I do that 

by assigning daily quizzes every day during the semester, usually one or two problems for 3 to 6 

points each day, and occasional extra quizzes or projects. At least 120 points will be assigned, but 
no more than 100 points will be counted. 

 Because I have found that telling people what the quiz problem is when they ask me 

outside of class seems to encourage them to miss class, I will not do that.  It is OK for you to 

learn what it is from your friend in class.  (Now is a good time for you to make an acquaintance in 
the class and possibly it will turn into a friendship!)    If you turn in a quiz on any day when 

you don't attend the full class, you must write a note on the quiz explaining how much of the 

class you missed.  Then I can deduct the one point for attendance, but give you credit for 

the work.  

 

Projects: 

Between 5 and 20 points worth of projects will be assigned through the semester.  Projects will 
usually be assigned a week before they are due.   Each of these is called a project because 

something a little different is expected than just what you normally do in homework or on 

quizzes.  These are part of the 120 possible points on quizzes/projects. 

 

Incomplete Grades:  Incomplete grades (I) will be given only in very rare circumstances.  Generally, to 

receive a grade of "I", a student must have taken all examinations, be passing, and after the last date to 
withdraw, have a personal tragedy occur which prevents course completion. 

 

Attendance Policy:   Attendance is required in this course.  Students who miss more than 4 classes may 

be withdrawn.   

 

Withdrawal Policy:  It is the student's responsibility to initiate all withdrawals in this course.  The 

instructor may withdraw students for excessive absences (4) but makes no commitment to do this for the 
student.   Before the official census date (Spring 2009:  February 4), a withdrawal from this course will 

take the course entirely off the transcript and no W will appear, so it doesn’t count as a withdrawal.  

Between then and the final withdrawal date (Spring 2009:  April 27), withdrawals do result in a W on the 
transcript.  After that date, neither the student nor the instructor may initiate a withdrawal. 

 

Students entering a Texas public college or university starting Fall 2007 and later are allowed only a very 
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limited number of withdrawals (i.e. Ws on their transcripts) during their entire undergraduate career.  For 

all students, withdrawals can have negative consequences, including increasing the tuition to be paid 
when the course is taken again and eligibility for financial aid.  Review this and other important 

information about withdrawals at http://www.austincc.edu/withdraw/ 

 

Reinstatement Policy:  In order to be reinstated, the student must demonstrate that he is caught up with 
the required work as of the date on which he wishes to be reinstated.   This must be done before the 

official last date to withdraw for the semester. 

 
Testing Center:  ACC Testing Center policies can be found at:  http://www.austincc.edu/testctr/.  You 

are required to look at those policies before you use the Testing Center.  Three very important policies are 

(1) if you leave the Testing Center you must turn in your test and you cannot return and resume taking it,  
(2) you must leave when the Testing Center closes, whether you have finished or not, and (3) during the 

test you may not have a cell-phone, pager, or any other materials with you.  Those must be left in your car 

or on the shelves in the Testing Center.    
 
Course-specific support services:   At NRG on Fridays from 11:45 – 2:00 in room PB1, we have a 

statistics lab, MATH 0159, Synonym 25346.  Here you can get tutoring help from Gustavo Cepparo, who 

teaches more of the MATH 1342 classes than any other teacher at NRG.   This class officially starts in 
late September and goes through the end of the semester.  Sign up for it like a regular class before Sept. 

15 and pay for one credit hour.  Ask in class if you need help during the first few weeks.  Probably some 

one of the statistics teachers will be there from 12-1 even during the first few weeks of the semester.    

 

ACC main campuses have Learning Labs which offer free first-come first-serve tutoring in mathematics 

courses.  At NRG it is in room 4119.  Students should bring their text, course handouts, and notes when 

they come to the Learning Lab.  Not all math tutors can tutor statistics, so ask in advance for the names 
and hours of tutors who are qualified for statistics.  For locations, contact information and hours of 

availability of the Labs see http://www.austincc.edu/tutor/  

 
ADDITIONAL COURSE POLICIES:   

 Students with Disabilities: Each ACC campus offers support services for students with 

documented physical or psychological disabilities, whether permanent or temporary. Students 

with disabilities must request reasonable accommodations through the Office of Students with 

Disabilities on the campus where they expect to take the majority of their classes. Students are 
encouraged to do this three weeks before the start of the semester. Students who are requesting 

accommodation must provide the instructor with a letter of accommodation from the Office of 

Students with Disabilities (OSD) at the beginning of the semester.   Accommodations can only be 
made after the instructor receives the letter of accommodation from OSD. 

 

 Scholastic Dishonesty:  Acts prohibited by the college for which discipline may be administered 

include scholastic dishonesty, including but not limited to, cheating on an exam or quiz, 
plagiarizing, and unauthorized collaboration with another in preparing outside work.  Academic 

work submitted by students shall be the result of their thought, work, research or self-expression.  

Academic work is defined as, but not limited to, tests, quizzes, whether taken electronically or on 

paper; projects, either individual or group; classroom presentations; and homework.   
Students who violate the rules concerning scholastic dishonesty will be assessed an academic 

penalty that the instructor determines is in keeping with the seriousness of the offense. This 

academic penalty may range from a grade penalty on the particular assignment to an overall grade 
penalty in the course, including possibly an F in the course. ACC's policy can be found in the 

Student Handbook under Policies and Procedures http://www.austincc.edu/handbook 
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 Academic Freedom:  Institutions of higher education are conducted for the common good.  The 

common good depends upon a search for truth and upon free expression.  In this course the 

professor and students shall strive to protect free inquiry and the open exchange of facts, ideas, 
and opinions.  Students are free to take exception to views offered in this course and to reserve 

judgment about debatable issues. Grades will not be affected by personal views.  With this 

freedom comes the responsibility of civility and a respect for a diversity of ideas and opinions.  

This means that students must take turns speaking, listen to others speak without interruption, and 
refrain from name-calling or other personal attacks. 

 

 Student Discipline:  Classroom behavior should support and enhance learning. Behavior that 

disrupts the learning process will be dealt with appropriately, which may include having the 
student leave class for the rest of that day. In serious cases, disruptive behavior may lead to a 

student being withdrawn from the class. ACC's policy on student discipline can be found in the 

Student Handbook or on the web at http://www.austincc.edu/handbook/ 
 

 Student Services 
Classroom behavior should support and enhance learning. Behavior that disrupts the learning 

process will be dealt with appropriately, which may include having the student leave class for the 

rest of that day. In serious cases, disruptive behavior may lead to a student being withdrawn from 
the class. ACC's policy on student discipline can be found in the Student Handbook under 

Policies and Procedures or on the web at: http://www.austincc.edu/handbook 
 

CLASS RULES: 
1. In accordance with school policy, you may not bring food or drink into class.  

2. You must turn off or mute volume on beepers and cellular phones BEFORE CLASS BEGINS so as 

not to disrupt class.  
3. Arrive for class a few minutes early so that you can have your materials out and be ready to start class 

on time. 

4. Disruptive behavior (talking to others while I am lecturing, rudeness, etc.) will not be tolerated.  
5. Class discussion will focus on the material being presented and will be about matters relevant to the 

entire class.  Discussion of your individual situation belongs in office hours or, occasionally, in the 

part of the class time that I have identified as devoted to working individually with students.   

6. Children are not allowed to attend class with you.  
7. Remember you are here to learn; be prepared to participate in class discussion. We are all unique 

individuals and in this class everyone's opinion will be respected whether we agree or disagree.  

8. Counseling services are available to help you with a variety of needs, if you would like more 
information please ask.  

9. Ask immediately if you need help! I am here to help you learn. Getting behind even one day will 

cause you to be confused and frustrated.  And it is very difficult to catch up after getting behind much 

more than one day.  Don't let that happen!! 
10. Quiz problems will never be accepted late.  A moderate amount of extra credit on quizzes is available 

to everyone.  This is adequate to take care of a reasonable number of absences without a grade 

penalty. 
11. Tests may not be taken late.  Some flexibility is allowed in the times to take the test, and a make-up 

option is provided for missing one of Tests 1-3. 

12. The final exam is given in class on the last day and there are no other times available.  
13. If you enroll in the class late, you are subject to the same rules as students who enrolled in the class 

before the class began.  The standard grading scheme allows enough flexibility for all students to 

make up a reasonable number of absences.   
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Orientation Assignment for MINITAB (14 or 15) Statistics Software 

(nothing to hand in) 
Mary Parker, mparker@austincc.edu 

 

When you do computer work in this class, never spend more than 5 or 10 minutes being "stuck".  
Write down a question and ask it.  Of course, don’t wait until the last minute or you won’t have time 

for that! 

 

 

Part I.  Use MINITAB.  (pages 1-2) 

Part II.  Find the data files for the problems in our text. (pages 2-3) 

Part III.  Where to get help / how to prepare your work.  (page 4) 
 

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 

Part I.  Use MINITAB. 
 

Here is a very small dataset of quiz grades for students in an algebra class.  Each pair is an individual 
student’s first quiz grade and his eighth quiz grade.   Type the dataset into the worksheet and then use 

MINITAB to summarize and analyze it in various ways. 

 

x y 

0 3 

0 4 

1 7 

3 7 

4 8 

7 10 
 

1. Open MINITAB.  Type all this data in the worksheet, with the x’s in 

Column 1 and the y’s in Column 2.  Make sure to put the labels x and y are 

at the top of each column – BEFORE row 1.   

 
2. Use MINITAB to find various numerical summaries of the data in Column 

1.   

Stat > Basic Statistics > Display Descriptive Statistics.   (The mean is a 
name for the usual average – add all the scores up and divide by the number 

of scores.  Here it is 2.50.  Did you get that? 

 

3. Use MINITAB to make a histogram of the data in Column 1.  Graph > Histogram.  (For more 
explanation, see MINITAB Manual, Chapter 1.) Choose “Simple.”   Then put either the C1 or the 

name x in the box as the variable you want to graph.  Or put your cursor over the correct variable 

and double-click to enter it into the box.  Make sure it’s there.  Then click on OK.  Your graph 
should look like the histogram on the left of the three graphs after number 7. 

 

4. Use MINITAB to make a scatterplot of the two columns of data.  Graph > Scatterplot  and then 
choose “Simple.”  (For more explanation, see MINITAB Manual, Chapter 4.)  Put the variables in 

the appropriate places and then click on OK.   Your graph should look like the one in the middle 

after number 7.  

 
5. Use MINITAB to find the correlation coefficient of the two variables.  (You’ll learn what that 

means in Chapter 4.)  Use Stat > Basic Statistics > Correlation.  It doesn’t matter what order 

you enter them.  (For more explanation, see MINITAB Manual, Chapter 4)   The answer is 0.917. 

6. Use MINITAB to find the cube root of the y variable here and put it in Column 4.  Use Calc > 

Calculator.  The exponent key on that calculator is labeled **. To take a number to an exponent, 

use **.  Obtain the cube root by using the power (1/3) with the parentheses.) (For additional 

help, see the MINITAB Manual, Chapter 0.  That’s not on StatsPortal.  Find it from 
http://www.austincc.edu/mparker/1342/tf/mm/ )    (Answers:  The first two numbers in column 4 

should be 1.442249, which is the cube root of 3, and 1.58740, which is the cube root of 4.)  
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7. Your instructor will tell you which method you’ll use in class to open data files.  Read that from 

Part II here.  Then open the data file for Chapter 5, exercise 5.42.  Note that the file name is ta05-
03.   Make a scatterplot with distance on the y-axis and time on the x-axis.  Your graph should 

look like the one on the right below. 

Task 3 Task 4 Task 7 
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Scatterplot of y vs x
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Scatterplot of distance vs time

 

General Comments: 

1. Which window is active?  Various windows include a Session window, a Data window, maybe a 
graph, etc.  To see which is active, go to the menu item "Window" and see which one at the bottom is 

checked.  Select a different one to be active if you wish.  Or, without going to the menu, look to see 

which has the darker title bar.  To make a different window active, move the cursor into it and click.  

Then it will have the darker title bar. 

2. Print a graph.  Make the Graph window active, then go to the "File" menu and choose "Print 
Window". 

3. Print all your Session Window.  Make the Session window active, then go to the "File" menu and 
choose "Print Window". 

4. Print a selection of your Session Window.  In the Session window, select (highlight) the part you 
want to print (which will also make the Session window active) and then go to the "File" menu and 

choose "Print Window".  

5. Copy a graph, all your Session Window, or a selection of your Session Window so that you can 

paste them into a word-processing document.   Follow the same instructions as above for printing, 

except use Edit > Copy to copy them to your computer’s clipboard.  Then open your word-
processing program and choose Edit > Paste to put them into the document.   

  

 

Part II.  Using the data files for the data in our textbook. 
 

If the dataset has more than about a dozen numbers, you probably don’t need to type it in.  
Instead you should use the data files provided.  There are several ways to use these, depending on whether 

you are using a school computer or your home computer and whether you are using MINITAB or 

Crunch-It.  Please learn how to use the first method below, called the “best and most flexible method.”   
After that, learn whichever shortcut works best for you. 

 

Find and identify the textbook datasets.   

1. On the CD in the back of the textbook, labeled Basic Practice of Statistics.  Explore the CD on 
your computer, finding the folder called Datasets, and then choose the subfolder that has the type 

of format you need for your files.   

2. Find the entire folder of datasets on the publisher’s website, as a zipped file. 
3. Use the e-book in StatsPortal to find the dataset for a particular exercise or example from an icon 

nearby. 
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4. On the computers in the math labs (math classrooms with computers), open MINITAB and 

choose File > Open Worksheet.   Then look around for the folder that is labeled for the Moore 
textbook.  Then change the “file types” to “All” in order to see the data files. 

 

How are the data files for the textbook named? 

 
1. TABLE:  If the data is given in a table, as for Chapter 1, problem 35, where the data is in table 

1.5, then the datafile name starts with ta.   Here it is ta01-05.   You may not have your computer 

set up to see file extensions, which is the part of the file name after this.   The data for our text is 
provided in lots of different formats, which are distinguished by the file name extensions.  For 

instance, if you find this file in the PC-Minitab folder, it is named ta01-05.MTP which is a file 

specifically to be read in MINITAB.  If you find this file in the PC-Ascii folder, it is named ta01-
05.DAT.  That file is in text form and can be opened and read by any word-processor or text 

editor.  Once it is opened in the word-processing program, the text in this file can be copied and 

pasted into either MINITAB or Crunch-It.   

 
2. EXERCISE: If the data is just given in the exercise, but not in a table, as for chapter 1, problem 

36, then the filename starts with ex.  Here it is ex01-36.  All the file extension information is the 

same as described in the previous paragraph. 
 

3. EXAMPLE:  If the data is given in an example, such as Example 1.2 on page 7, then the filename 

starts with eg.  So it is eg01-02 for this example.  All the file extension information is the same as 
described for the data files from tables above.    

 

Use the textbook datasets in MINITAB or Crunch-It.   

 
1. Best and most flexible method for both programs:  Open the file from the ASCII folder in a 

word-processor and copy and paste it into either MINITAB or Crunch-It.  Pay attention to getting 

the labels for the columns in the right place – on top of the column, not in the first row of data. 
 

When you use Crunch-It, use the menu Data > Load data > from paste .  Then paste the data 

(that you already copied) into the textbox.  Pay attention to whether the labels for the columns are 

included or not and check or uncheck the box under where you pasted the data, as appropriate.  
 

When you use MINITAB, you just paste directly into the worksheet, starting with the label row in 

the worksheet or not, depending on whether labels are included.  If you make a mistake and put 
labels on the first data row, this will cause major problems.   Delete that worksheet and start over.   

 

2. Very simple method to use at home when you’re connected to the Internet, for both 
programs:  In StatsPortal, go to the e-book, click on the icon next to the problem.  Use this for 

Crunch-It.  If you have purchased and installed MINITAB on your computer already, and you use 

the MINITAB icon instead, it will also work with MINITAB.  (This method won’t work well on 

the school computers because MINITAB 14 is called from a network at school and so clicking on 
the MINITAB datafile doesn’t open MINITAB 14.) 

 

3. One method to use at home with MINITAB only.  Insert the textbook CD, explore it to find the 
PC-Minitab folder of data.   Double click on the appropriate data file in that folder.  If you have 

MINITAB installed on your computer, this should open the file in MINITAB.   

 
4. Usual method to use at school with MINITAB only:  Open MINITAB, go to File > Open 

Worksheet and then look for the directory that has the datasets for our text.   It will look empty.  

Under “File Types” choose “All.”  This will be confusing if you forget to change the file types 
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option or if you choose “Open Project” instead of “Open Worksheet” because there are no project 

files.   
 

5. Set up your home computer to use MINITAB data files as you do at school.   Look on the 

textbook CD and find the PC-Minitab folder of data.  Copy the entire contents of that folder.  

Then go to the MINITAB program file (probably under C:\Program Files\Minitab 14 Student\) 
and create a new folder under the Data folder.  Call it Moore-data.   Then paste the datasets into 

it.   

 

Part III.  Where to get help / How to prepare your work. 
 

Decide what analyses to do in MINITAB 

As you learn the material in the chapters of the text, you’ll learn how to choose analyses.  For 

instance, in Chapter 1, you will look at whether the data are categorical or quantitative, and 

choose an appropriate type of graph.  In Chapter 4, you will learn that the appropriate graph to 
present quantitative data on two variables is a scatterplot.  

 

Find instructions for doing analyses in MINITAB 
The MINITAB Manual provides instructions, screenshots for MINITAB 14/15, and statements of 

the same problems as those in the textbook, but with more information about what menu items to 

choose in MINITAB.  You can either have this open in a separate window on your computer 

while you are using MINITAB, or you can print out each chapter as you need it and have a print 
copy with you.  This will be available from “Resources” in StatsPortal under Technology 
Manuals.   

 

Prepare homework/quizzes that require some MINITAB output 

Most exercises that require some MINITAB output also require some interpretation.  Those 
interpretations are very important.  When you turn in your work on such problems, be sure that 

the interpretations are on the same page as the output and that the presentation of the total answer 

to the problem is clear.  Generally speaking you can write your interpretations in pencil on the 
printed output page.   Alternatively, you can prepare your solution as a word-processing 

document, where you copy something (Edit > Copy)  from MINITAB  and paste it (Edit > Paste) 

into your word-processing document. 

 

Recognize that you can use software on some problems even when there isn’t a data file. 

 

1. If you open your software program without having a data file, you can simply type data into the 
blank worksheet.  Be sure to notice the difference between row 1, where you start the data, and 

the blank row above that, where you put labels, like “height” or any other appropriate name for 

the data.   In this course you may be asked to type in small datasets.  NEVER spend time typing 

in large datasets – you need your time available for other work in the course. 
 

2. Some statistical analyses don’t use raw data.  In Chapter 8, some of the problems require you to 

just enter the ID numbers you assigned as the data.  (Make patterned data.)  In Chapters 20 and 
21, for instance, all the data is given in summarized form and so you just type in the summary 

statistics in the appropriate boxes.  The instructions in the MINITAB Manual explain this. 

 

When you do computer work in this class, never spend more than 5 or 10 minutes being "stuck".  

Write down a question and bring it to the next class.  Of course, don’t wait until the last minute or you 

won’t have time for that! 

 

 



MATH 1342.014   Instructor:  Mary Parker  Synonym  31266           

 

page 10 of 15 

 

Project A (3 pts) :  (Can be done after Chapter 1)   Due Date:  _________ 

Example:  I might want to measure the lengths of cats.  The cases (also called individuals) are cats, and 
the variable is “length”, in inches, measured to the nearest inch.  Some questions which occur are  (1) 

Should I include the tail? and  (2)  If I include the tail, do I measure to the tip of the fur or just to the tip of 

the tail without the fur?  Other variables which might be interesting are  “weight” and their “eye color”.   

Observations on the length of a cat might be 15 inches, 18 inches, 12 inches, and 13 inches. 
You make up another example.  Think of some variables which you might be interested in analyzing. 

1.  What is the question you’re interested in investigating? 

2.  Describe what a single case is for this investigation. 
3.  Describe three different variables that could be measured on that case. 

4.  Pick one of the three variables (underline it) and describe how you would measure it and what the 

units will be.  Are there likely to be any problems or ambiguous situations? 
5.  For that variable, give four observations that would be reasonable to see. 

 

Project B (3 pts):  (Can be done after Chapter 2)  Due _______ 

Use this set of numbers:  4, 5, 8, 9, 9 
1.  By hand, showing all work, find the mean. 

2.  By hand, showing all work, find the standard deviation. 

3.  Use the information at http://www.austincc.edu/mparker/1342/calculators/  to find how to use the 
mean and standard deviation keys on your calculator.  Use them to find the mean and the standard 

deviation.  Make sure they're the same as in 1 and 2. 

4.  Write down instructions for yourself about how you did these calculations on the calculator.  
 

Project C:  (3 pts)  Data: Chapter 7, problem 44. (Use MINITAB.)   Due Date:  _______________ 

1. Make an appropriate graph to illustrate the distribution of the thickness.  Describe the distribution: 

shape, center, and variation. 
2. Make an appropriate graph to illustrate how the thickness is related to the velocity.  Summarize this in 

words and numerical estimates.   

 
Project D:  (6 pts)  Plan a statistical study that you could actually do if you had about 20 hours available 

to do it.  Due Date: ___________ 

1. Formulate the question. Think of a question of interest to you for which you (you, as a student and an 

individual) could collect some data.  
Examples:  

a. What percentage of cars don't completely stop at the stop sign at the north corner of Waterston 

and Hartford?  
b. In a blind taste test, do people prefer Classic Coke to Pepsi?  

c. How accurately could we predict hat size from forearm length?  

Write the question and explain how this question is of interest to you or someone. How might 

accurate knowledge about the answer change someone's actions?  
2. Identify relevant variable(s).  

Explain what the variable(s) is and how you expect to measure it. Discuss any definitions needed. 

(Remember the example about the length of a cat -- does that include the tail or not?)  
3. How would you collect useful data?  

Is this a question for which you just go collect data or do you have to set up an experiment? (Example 

b above requires you to set up an experiment.) Explain how you could get a reasonable sample or 

set up a reasonable experiment. Describe the population in which you are interested and explain 

how this method of collecting data should get representative data from this population.   

4. Does your sampling scheme or experimental design fit one of the accepted methods described in 
Chapters 8 or 9?  If so, identify which.  If not, why do you think it is reasonable?  Would it have any 

of the problems that were identified in that chapter? 
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 Homework Guidelines and Exercises, MATH 1342, BPS 4
th

 edition 

 
Which exercises:   

 The main homework exercises are listed in bold type in the list below.  The non-bold exercises 

at the in brackets at the beginning of each chapter’s list are for those who need immediate practice as they 

are reading through the chapter.  Some of them will probably be covered in the lecture.     

 

Checking answers and showing your work: 

 Most of the assigned exercises have short answers in the back of the book, and more complete 
answers in StatsPortal.  You may be tempted to read the exercise, read the answer, and then decide 

whether it makes sense to you.  That is not a good strategy to learn the material.  In order to be able to do 

problems like these on tests, you must practice doing them yourself.  Use the textbook examples when 
you want to read a solution and the exercises to practice solving them yourself.  Work the exercise 

yourself completely, or at least write a question about what you don’t understand before you look at the 

answer.   

 

Check Your Skills questions: 

 These short multiple-choice questions at the end of each chapter before the exercises are 

provided so that you can quickly determine whether you have seen the basic ideas in the chapter. Before 
you start the homework, use these to give yourself a quick overview of the material.  If you miss any, 

review that section of the chapter before starting the exercises.   

 
Technology:   

 Exercises with a (T) require some form of technology (statistical calculator, applet, Crunch It 

software, or MINITAB) to do some part of the problem.  Problems with (M) have some part for which 

you are required to be able to MINITAB, specifically.  You may use MINITAB on additional exercises if 
you wish.  Most, but not all, of those exercises are also given in the MINITAB Manual, with more explicit 

directions about how to use MINITAB to do them.  Please look there before you start using MINITAB for 

a problem.  Most, but not all, of the exercises which require MINITAB have data files available so that 
you don’t have to type in the data.  When you start using MINITAB, you should definitely learn to find 

those datafiles so that you don’t waste time typing in a lot of data.  However, sometimes you will need to 

use MINITAB for an exercise for which there is not a data file.  For those exercises, either the dataset is 

so small it is easy to type in, or no dataset is needed.  See the examples of similar exercises in the 
MINITAB Manual.  

 

 On the problems requiring technology, as on all homework, you should spend as much time and 
thought answering questions about what the results mean as you spend calculating.  Your answers should 

reflect this.   During the tests, you will not have computer access and may not even be allowed to use a 

graphing calculator.   Test questions will be adjusted to reflect the tools you have available at that time.   
Ask your instructor in advance what you will be allowed to use on each test.    

 The electronic textbook in StatsPortal has links to the datasets for many of the exercises that use 

technology.  You should be able to find the datasets without that, but you may find it convenient to use 

these links most of the time.  

 

Specific Instructions:   

 
1. Do most of the homework problems by handwriting and get a looseleaf notebook to keep it 

organized.  Don’t use a spiral notebook, because you will need to insert computer output and 

additional pages from time to time. 
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2. Keep a cover sheet for each  set of homework (four to six chapters) listing every exercise in 

the homework, including those in brackets, and a notation about your experience doing it.  
Use these to keep up with what questions you need to ask and which problems were hard for you.  

Review the hard ones again before the test.   Put the following symbol or comment beside each 

one. 

 Complete and correct the first time, before checking in the back of the book or with 

others  (   -- Check mark)  

 Had a question about it or did it incorrectly when I first looked at it, but eventually 

figured it out (? ) 

 Had a question about it or did it incorrectly and never figured it out (?) 

 Didn’t do it.  I read it and it was obvious how to do it and I didn’t need the practice.  ( E, 

for “Not done, too easy”)  (This is the notation you should use for most of the problems 

in brackets at the beginning of each set.) 

 Didn’t do it because I just ran out of time.  (X) 

3. If you look back at an example to see how to do a problem, be sure you understand the reasons 

for each step.  If you don't, write a question and leave space to write the answer when you find it. 

4. If you cannot work a problem, write a question in a complete sentence about what you don't 
understand.  Make it as specific as possible so that when you learn the answer to that question, 

you will be able to make progress on the problem.  Leave room  to write the answer to that 

question when you find it.  Then ask your question on the Discussion Board and, a couple of days 

later, write down what you learned.  Get all questions answered BEFORE you take the test, which 
means before you turn it in. 

5. Show enough work (and draw enough pictures) that two weeks later you can remember what 

you did to solve the problem. On the test you will not have several problems of one type all 
together.  You will have to rely on the instructions and the statement of the problem for guidance 

in how to proceed.  Make your homework solutions useful for reviewing before the test. 

6. Practice reading the problem carefully on every homework problem!   

7. Many students waste time while doing the homework by not asking questions soon enough.   

When something confuses you, ask yourself if you have seen any explanation relevant to this and 

review it once. After you have done that, and then if you have spent 10 minutes trying to 

understand some specific point without success, you should spend several minutes writing as 
specific a question as you can about what you don’t understand.  Submit that to the Discussion 

Board.  Then leave that particular subtopic until you have an opportunity to get your question 

answered. Often you can simply go to the next homework question.  There is always something 
else productive to spend your time on until you get an answer.   Learning to formulate good 

questions and get them answered is actually more important to your future success than 

learning the statistical techniques. 

8. For problems which require computer output, such as graphs, the main part I will grade is your 

interpretation of the computer output, in terms of the question asked.  Print the graph or other 

relevant output and then write your interpretations on the same page.  Make your solution as clear 

and well-organized as you would if you were giving it to your supervisor at work. 

9. Don’t copy solutions directly from the Study Guide or from the answer keys.   
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Homework Grades: 

 
When I grade the homework, I won’t look at every single problem to see if it is right.  You’re supposed to 

be doing that.  I will judge it on completeness and whether your cover sheet is complete and honest.     

See the chart below for what grade to expect.  A typical good student who is turning in homework for a 

grade will be trying for a grade of 16-20 on each homework assignment.    

Grade Required 

20 All exercises.  (Most students don’t need this much practice.  Only do as much 

homework as you need to understand the material.) 

20 All bold exercises. 

16 Most of the bold exercises, definitely including all the bold MINITAB exercises. 

12 About 60% of the bold exercises, definitely including all the bold MINITAB 

exercises.  Or all the problems in [  ] and about 30% of the bold exercises, including at 

least one MINITAB problem in each exercises, if any were assigned.   No entire 
chapters omitted. 

8 About 40% of the bold exercises.  Or all the problems in [  ].   

 

HW1: 

Chapter 1:  [1.1, 1.3, 1.5, 1.7, 1.9, 1.11, 1.13-1.22], 1.23, 1.27, 1.29, 1.31, 1.32, 1.39, 1.41, 

1.44(M), 1.45(T) 

Chapter 2: [2.1, 2.3, 2.5, 2.7, 2.9(T), 2.12, 2.13-2.22], 2.23, 2.29, 2.31, 2.35, 2.37, 2.41(T), 2.43, 

2.45(T)  

Chapter 3:  [3.1, 3.2, 3.4, 3.5, 3.7, 3.9, 3.10, 3.11, 3.12, 3.13, 3.14, 3.15-3.24], 3.25, 3.27 3.29, 

3.30, 3.31, 3.35, 3.37, 3.39, 3.41, 3.45, 3.49 

Chapter 4:  [4.1, 4.3, 4.4&4.5(M), 4.7, 4.8ac(M), 4.9, 4.10(M), 4.11(M),, 4.12-4.21], 4.23, 

4.25(M), 4.26, 4.27(M), 4.29, 4.31, 4.35, 4.37(T), 4.41(M) 

HW 2: 

Chapter 5: [5.1, 5.3(M), 5.5(M), 5.6, 5.7(M), 5.9(M), 5.11, 5.13, 5.15, 5.17, 5.19, 5.21, 5.23(M)], 

5.25, 5.27(M), 5.31, 5.33(M), 5.34(M), 5.35(M), 5.37, 5.39(T), 5.45(M), 5.51, 5.54(T) 

Chapter 6: [6.1, 6.3, 6.5, 6.7, 6.9 – 6.18], 6.19, 6.21, 6.23, 6.25, 6.27, 6.29, 6.31 

Chapter 7: Review  7.1, 7.5(M), 7.7(M), 7.9(M), 7.11(M), 7.13(M), 7.15(M), 7.17(M), 7.18(M), 

7.23, 7.25 

Chapter 8: [8.1, 8.3, 8.5, 8.7, 8.9, 8.11, 8.13(both by hand and M), 8.15, 8.17 – 8.26], 8.27, 8.31, 

8.33, 8.35, 8.37, 8.42(M), 8.43, 8.44, 8.45, 8.50 

Chapter 9: [9.1, 9.3, 9.5, 9.7, 9.9, 9.11, 9.13, 9.15, 9.16 – 9.24], 9.25, 9.29, 9.33, 9.35, 9.37, 9.43, 

9.45(M), 9.47 

Data Ethics (page 242-243):  1, 3, 7 

HW 3: 

Chapter 10: [10.1, 10.3, 10.5, 10.7, 10.9, 10.11, 10.13, 10.15, 10.17, 10.19 – 10.28], 10.29, 

10.31, 10.35(T), 10.39, 10.43, 10.46, 10.48, 10.49 
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Chapter 11: [11.1, 11.3, 11.5, 11.7, 11.9, 11.11, 11.13, 11.15, 11.17 – 11.24], 11.25, 11.28, 

11.31, 11.35, 11.39, 11.41, 11.43(M), 11.45, 11.49 

Chapter 14: [14.1, 14.3(T), 14.5, 14.7, 14.9, 14.11-14.20], 14.24, 14.25(M), 14.27, 14.28, 

14.29(M), 14.33, 14.35, 14.36, 14.37, 14.39(T) 

Chapter 15: [15.1, 15.3, 15.5, 15.7, 15.9, 15.11(T), 15.13, 15.15, 15.17, 15.19(M), 15.21, 15.23, 

15.25, 15.26-15.35], 15.37, 15.39(M), 15.43, 15.45, 15.51, 15.53 

Chapter 16: [16.1, 16.3, 16.5(T), 16.7, 16.9, 16.19-16.27], 16.15, 16.31, 16.34(a, b), 16.35, 

16.37, 16.38, 16.39(M), 16.41, 16.43 

Chapter 17: Review 17.9, 17.11, 17.17, 17.19, 17.25, 17.27, 17.29(M), 17.31(M), 17.39, 17.43 

HW 4: 

Chapter 18: [18.1, 18.3, 18.5, 18.7(M), 18.9, 18.11(M), 18.13(M), 18.15-18.24], 18.27(M), 

18.29, 18.33, 18.34, 18.35, 18.39(M), 18.43(M), 18.44(M) 

Chapter 19: [19.1, 19.3, 19.4, 19.5, 19.7(M), 19.9(M), 19.11(M), 19.13, 19.15, 19.22-19.29] 

19.31(M), 19.35, 19.37, 19.39, 19.42, 19.43, 19.45(M), 19.51(M) 

Chapter 20: [20.1, 20.3, 20.5, 20.7, 20.9, 20.11, 20.13, 20.15(M), 20.17, 20.18-20.27], 20.29, 

20.31(M), 20.32, 20.33, 20.34, 20.35, 20.37, 20.41(M) 

Chapter 21: [21.1, 21.3, 21.5(M), 21.7-21.14], 21.15, 21.17, 21.19(M), 21.20(M), 21.21(M), 

21.24, 21.27, 21.31    

Chapter 22: Review 22.1, 22.2, 22.3, 22.4, 22.17, 22.25, 22.31(M), 22.41(M), 22.43(M) 

HW 5: 

Chapter 23: [23.1, 23.3, 23.5, 23.7, 23.9, 23.11, 23.13(M), 23.19-23.28], 23.29(M), 23.31, 

23.33(M), 23.35, 23.41(M) 

Chapter 24: [24.1(M), 24.3(M), 24.5, 24.7, 24.9, 24.11, 24.13, 24.15, 24.16-24.24], 24.25, 

24.27(M), 24.29, 24.31, 24.33(M), 24.34(M), 24.36, 24.38(M)    


